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1 Premessa 1

1 Premessa
In questo documento verranno descritti nel dettaglio tutti i passi necessari per risolvere un
problema fluidodinamico, la cui geometria è particolarmente semplice, con ANSYS CFX 14
(nel seguito CFX per brevità). A tal fine, faremo uso di ANSYS Workbench (WB nel seguito),
le cui caratteristiche lo rendono particolarmente conveniente ed agevole per comprendere la
sequenza di passi che si utilizzano per qualsiasi analisi CFD. In altre esercitazioni non si farà
uso, per comodità, di WB, sebbene il suo utilizzo sia sempre possibile.

Il problema scelto, come detto, è particolarmente semplice dal punto di vista geometrico,
è ciò ci consentirà di definire la geometria direttamente all’interno di WB tramite ANSYS
Design Modeler (DM nel seguito), anziché importare la geometria generata attraverso un
CAD esterno. Tuttavia, si tratta di un problema con interessanti caratteristiche:

• Flusso con peculiarità non banali (moti secondari);

• Ampia disponibilità di dati sperimentali, globali e locali;

• Accuratezza, qualitativa e quantitativa, delle previsioni fortemente influenzata dalle
modalità di analisi.

È forse superfluo segnalare che esistono numerosi casi analoghi, in letteratura, caratteriz-
zati da geometria semplice e caratteristiche del moto non banali o complesse, che quindi ben
si prestano come argomento per lo student project.

2 Descrizione del problema
Si desidera studiare il flusso turbolento, per un fluido incomprimibile (acqua a 20 ◦C) ed in
assenza di scambio termico, attraverso una curva (gomito) a 90◦ di una tubazione a sezione
circolare, come rappresentata in figura 1.

I dati del problema sono riassunti in tabella 1.

Dati caratteristici del problema.

D = 50 mm
L1 = 200 mm
L2 = 300 mm
ri = 100 mm
re = 150 mm
Um = 0.2 m/s
µ = 8.899 × 10−4 kg/(m s)
ρ = 997 kg/m3

Re = ρUmD
µ = 9980

Tabella 1: Dati per il gomito a 90 ◦.
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2 2 Descrizione del problema

Figura 1: Dimensioni caratteristiche del gomito a 90 ◦.

Dai rilievi sperimentali (H. Nippert, 1929 1) per questo problema, si è osservato:

1. Eventuale presenza di fenomeni di separazione, sia all’estradosso che all’intradosso, in
quest’ultimo caso a valle del punto di maggior curvatura;

2. Sovrapposizione, al moto principale, di una corrente secondaria, che tende a spostare i
valori massimi della velocità verso il lato esterno, e la cui origine può spiegarsi come
segue. Se il moto fosse irrotazionale il profilo di velocità, uniforme nel tratto rettilineo,
nel tratto in curva presenterebbe valori maggiori verso l’interno (convessità) e minori
verso l’esterno (concavità). Secondo il principio di conservazione dell’energia meccani-
ca (teorema di Bernoulli), pertanto, vi sarebbe una progressiva trasformazione di energia
cinetica in energia di pressione lungo la parete esterna, e una trasformazione contraria
per la parete interna. A seguito degli attriti, però, il fluido in prossimità delle pareti
è più lento di quello del modello irrotazionale, e quindi tanto il recupero di pressione
sul lato esterno, quanto l’abbassamento di pressione sul lato interno, saranno inferiori
ai valori teorici. Rispetto alla situazione prevista dal modello irrotazionale, ci sarà uno
squilibrio delle pressioni il quale determina un certo trasferimento di fluido dall’interno
verso l’esterno della curva.

3. La corrente secondaria che in tal modo si determina, tende a spostare i valori massimi
della velocità verso il lato esterno, come illustrato nei rilievi sperimentali di figura 2,
ed a creare un doppio moto spiraliforme che ha importanti conseguenze: oltre a pro-
durre un’ulteriore dissipazione di energia, questi moti secondari si estendono per un
tratto molto lungo dopo la fine della curva - anche 40− 60 diametri - e possono falsare
notevolmente le misure, eseguite con venturimetri, contatori etc., posti ad insufficiente
distanza dalla curva stessa.

1Nippert, H. 1929, Uber den Strömungswiderstand in gekrümmten Kanälen. Forschungsheft Arbeit
Ingenieur-Wesen, no. 320.
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Figura 2: Caratteristiche del moto in un gomito a 90 ◦ rilevate sperimentalmente.

3 Analisi del problema con ANSYS Workbench e CFX

Avviare ANSYS WB tramite l’icona presente sul desktop, oppure tramite

Tutti i programmi→ ANSYS 14.0→ Workbench 14.0
L’interfaccia di WB si presenterà come in figura 3.

Figura 3: Avvio di ANSYS WB.

Selezionare le unità di misura SI o metriche dal menù Units come in figura 4. È opportuno
notare che sarà sempre possibile modificare tale scelta in seguito, anche personalizzando i
valori delle unità di misura per ciascuna grandezza, dal menu Units di WB. Selezionare, dal-
l’elenco di sinistra, nel gruppo Analysis Systems, Fluid Flow (CFX) e trascinarlo nella finestra
principale, come in figura 5.
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Figura 4: Selezione delle unità di misura in ANSYS WB.

Figura 5: Selezione di CFX in ANSYS WB.
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La finestra principale si presenterà ora come in figura 6, nella quale si potrà notare che
le varie voci, dette celle (cells) in WB, che compongono lo schema del progetto - Geome-
try, Mesh, Setup, Solution e Results - sono distinte da un punto interrogativo, a significare
l’assenza di dati o la presenza di errori.

Figura 6: Inizio dell’attività in ANSYS WB.

Sarà ora necessario procedere, dall’alto verso il basso, iniziando da Geometry e, una volta
completata tale fase, passare a Mesh e cosı̀ via. Ogni qualvolta una fase (cella) verrà comple-
tata correttamente, essa si presenterà, anziché con un punto di domanda, con un simbolo di
checkmark ( ) di colore verde.
A questo punto è opportuno elencare i diversi stati possibili delle celle, rimandando all’Help
disponibile per maggiori informazioni:

Typical Cell States (Stati comuni)

Unfulfilled (Insoddisfatto)
I dati a monte (upstream) della cella non esistono. Il caso tipico è l’assenza della
geometria: tutte le celle a valle si troveranno in questo stato.

Refresh Required (Refresh richiesto)
I dati upstream sono stati modificati dall’ultimo Refresh o Update e può essere
necessario o meno rigenerare i dati di output. Quando una cella è in tale stato vi
sono in generale più opzioni:

• Editare e rivedere i dati unrefreshed.
• Fare un Refresh dei dati, ma senza incorrere in operazioni che possono richiedere

molto tempo, quale ad esempio la generazione di una nuova mesh in caso di
modifica della geometria.
• Fare un Update della cella, che darà luogo ad un Refresh e rigenerazione dei

dati, quale ad esempio generazione di una nuova mesh nel caso la geometria
sia stata modificata.
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6 3 Analisi del problema con ANSYS Workbench e CFX

Il vantaggio di poter eseguire un Refresh, invece che un Update, riguarda la pos-
sibilità di ottenere informazioni diagnostiche sulle celle a valle senza eseguire un
vero e proprio Update, potenzialmente molto più costoso in termini di tempo e
risorse di calcolo.

Attention Required (Attenzione richiesta)
Tutti gli input della cella sono aggiornati, ma è necessaria un’azione correttiva da
parte dell’utente, su questa o sulla cella a monte (si noti che, a differenza del caso
Unfulfilled, il simbolo è pieno).

Update Required (Update necessario)
I dati locali della cella sono stati modificati e perciò l’aoutput della cella stessa
dev’essere rigenerato. Nell’aggiornamento di una cella che richiede il Refresh,
verrà prima eseguita l’operazione di Refresh, seguita dall’Update.

Up to Date (Aggiornato)
La cella è stata aggiornata senza inconvenienti. È possibile editare la cella, ed essa
è in grado di fornire dati aggiornati alle altre celle.

Input Changes Pending (Modifiche dell’input in attesa)
La cella è aggiornata, ma il suo stato potrebbe cambiare a seguito dell’aggiorna-
mento di celle a monte.

Solution-Specific States (Stati specifici per le celle di soluzione/analisi)

Interrupted (Interrotto)
La soluzione è stata interrotta in modo corretto: il solver ha completato la sua
iterazione ed ha prodotto un solution file (file dei risultati). Tale file può essere uti-
lizzato per il post-processing - ad esempio per verificare che la soluzione proceda
in modo fisicamente corretto - o per ripartire con la soluzione, usando la funzione
Resume o Update.

Pending (In attesa)
Il processo di soluzione è in corso, in modalità asincrona o batch.

Failure States (Stati d’insuccesso)

Refresh Failed, Refresh Required (Refresh fallito, Refresh richiesto)
L’ultimo tentativo di Refresh della cella è fallito: essa rimane in stato di Refresh.

Update Failed, Update Required (Update fallito, Update necessario)
L’ultimo tentativo di Update della cella, e conseguente aggiornamento dell’output,
è fallito: essa rimane in uno stato di Update necessario.

Update Failed, Attention Required (Update fallito, Attenzione richiesta)
L’ultimo tentativo di Update della cella, e conseguente aggiornamento dell’output,
è fallito: in questo caso essa rimane in uno stato di Attention Required.

Provvediamo intanto a salvare il progetto WB, nella cartella di lavoro scelta (è consiglia-
bile utilizzare una cartella di lavoro distinta per ogni progetto), selezionando l’icona Save as
dalla barra dei menù oppure da File → Save as, e nominarlo gomito (l’estensione .wbpj, da
WorkBench ProJect, verrà assegnata automaticamente), come in figura 7.
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Figura 7: Denominazione e salvataggio del progetto.

3.1 Generazione della geometria

Cliccare, posizionandosi su Geometry, con il tasto destro del mouse oppure doppio click e,
dal menù, selezionare New Geometry, come indicato in figura 8.

Figura 8: Avvio di ANSYS Design Modeler.

Verrà avviato DM e sarà necessario selezionare l’unità di misura delle lunghezze, come
illustrato in figura 9. Scegliere mm (selezionando, nel checkbox, Always use project units, si
utilizzerà sempre l’unità di misura di lunghezza precedentemente scelta in WB).

Figura 9: Scelta dell’unità di misura delle lunghezze in ANSYS DM.

Nella generazione della geometria, vi sono sempre più modalità per giungere al medesimo
risultato: la scelta, oltre, oltre che dettata dall’esperienza, dipende da numerosi fattori, quali:

• Facilità della successiva generazione della griglia, e qualità di quest’ultima;
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• Parametrizzazione della geometria, per successive analisi parametriche, ottimizzazioni
etc.;

• Esportazione dei risultati verso altri prodotti e/o altre fisiche (es. interazioni fluido-
struttura).

La figura 10 riporta l’ordine di generazione degli elementi adottato.

Figura 10: Ordine di generazione degli elementi geometrici del gomito.

Selezionare, nell’albero di sinistra, il piano YZ e, con il tasto destro del mouse, selezionare
l’opzione Look at per spostare la vista sul piano stesso.
Cliccare quindi sull’icona New Sketch ( ), presente in alto, e rinominare lo sketch (tasto
destro del mouse) in Diametro. La finestra di DM apparirà come in figura 11.

Figura 11: Generazione dello sketch Diametro.
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Spostarsi sul menu Sketching, a sinistra, e selezionare Circle nel sottomenu Draw, come
in figura 12. A questo punto:

Figura 12: Selezione dell’elemento Circle nel sottomenu Draw in Skeching.

• Posizionare il puntatore del mouse all’origine degli assi fino alla comparsa della lettera
’P’, indicante l’opzione di snap al punto;

• Premere il tasto sinistro del mouse, trascinarlo in senso radiale ed infine rilasciarlo per
definire il raggio;

• Selezionare il sottomenu Dimensions per definire in modo parametrico il valore del
diametro;

• Selezionare l’opzione Diametro;

• Spostare il mouse sulla circonferenza;

• Cliccare con il mouse per associare la quota D1 all’entità geometrica;

• Nel menu Details di sinistra digitare il valore del diametro, 50 mm, nell’apposita casella.

Il risultato finale è riportato in figura 13.
Nell’albero di Modeling selezionare lo schizzo da estrudere (Diametro), e:

• Cliccare sull’icona Extrude ( ) in alto;

• Rinominare l’estrusione in TuboMonte, in analogia a quanto già fatto con lo schizzo;

• Impostare la direzione di estrusione in Reversed;

• Definire la profondità di estrusione (Depth) a 200 mm;

E. Nobile, M. Morgut, P. Ranut - Febbraio 2013



10 3.1 Generazione della geometria

Figura 13: Scelta del diametro.

• Cliccare sull’icona Generate , presente nel menu in alto.

Il risultato è illustrato in figura 14, nella quale sono evidenziate le scelte indicate.
Riportarsi nuovamente sul piano YZ e:

• Generare un nuovo schizzo, da rinominare in Asse, come in figura 15;

• Selezionare gli strumenti di Sketching e dal menu Draw cliccare su Line;

• Tracciare al di sotto della circonferenza, mantenendo premuto il tasto sinistro del mouse,
una linea orizzontale. A tal fine, fare attenzione che ci sia una lettera ’H’ vicino al-
la linea, ad indicare che la linea è disposta orizzontalmente: il risultato sarà come in
figura 16;

• Passare al menu Dimensions e selezionare una quota verticale;

• Cliccare sulla linea da quotare, appena tracciata, e sull’asse orizzontale della circon-
ferenza - l’asse delle Y - per definire la quota;

• Definire, come in precedenza, il corretto valore della quota, pari a 125 mm, come
illustrato in figura 17.

Selezionare l’opzione di modellazione Revolve, indicata dal simbolo .

• Rinominare la feature in Gomito;

• Nella finestra di dettaglio, in basso a sinistra, associare a Geometry lo schizzo Diametro,
e alla voce Axis lo schizzo Asse (è sufficiente, una volta selezionato con il mouse lo
schizzo Asse, premere Apply per associarlo all’asse di rotazione);

E. Nobile, M. Morgut, P. Ranut - Febbraio 2013



3.1 Generazione della geometria 11

Figura 14: Generazione del tratto di tubo a monte del gomito.

Figura 15: Generazione dello sketch Asse.
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Figura 16: Asse orizzontale.

Figura 17: Quotatura asse orizzontale.
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• Impostare, sempre nella finestra di dettaglio, l’angolo di rivoluzione a 90◦;

• Cliccare su Generate: il risultato sarà come in figura 18.

Figura 18: Generazione del gomito.

Ruotare il tubo in modo da portare in primo piano la superficie a valle del gomito, come
in figura 19:

• Cliccare sull’icona New plane;

• Rinominare il piano in PianoValle;

• Nella finestra di dettaglio selezionare, tra i possibili tipi, From Face;

• Spostarsi su Base face, e selezionare la faccia nel viewpoint (superficie a valle del
gomito) e poi premere Apply;

• Infine cliccare su Generate per creare il piano.

Una volta ottenuto il piano, è necessario:

• Generare una nuova feature Extrude, rinominandola TuboValle, in analogia con quanto
già fatto in precedenza con Tubomonte;

• Nella finestra di dettaglio associare a Geometry il piano appena creato: in questo modo
vengono estruse tutte le superfici presenti nel piano;

• Definire una profondità di estrusione pari a 300 mm;

• Cliccare su Generate per generare la feature.
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Figura 19: Generazione del piano a valle del gomito.

Figura 20: Generazione del tubo a valle del gomito.
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Il risultato è illustrato in figura 20.
Salvare quindi la geometria appena completata col nome di Gomito: l’estensione .agdb,

Design Modeler DataBase files, verrà assegnata automaticamente, come riportato in figura 21.
Chiudere Design Modeler.
Nella finestra principale del progetto (Workbench) salvare, aggiornandolo, l’intero progetto.

Figura 21: Salvataggio della geometria.

3.2 Generazione della griglia di calcolo
Nella finestra principale posizionarsi con il mouse, nello schema del progetto, su Mesh clic-
cando con il tasto destro e selezionare Edit, come in figura 22, oppure doppio click col tasto
sinistro.

Figura 22: Avvio di ANSYS meshing.

Una volta completato l’avvio di ANSYS Meshing, il risultato sarà come in figura 23.
Cliccando su Mesh, nell’albero a sinistra del progetto, verranno visualizzate le infor-

mazioni riportate nella finestra di dettaglio a sinistra, riprodotta in figura 24. In particolare, si
potrà notare che, come Physics Preference è indicato CFD, mentre come Solver Preference è
selezionato, di default, CFX, senza necessità di ulteriore intervento da parte dell’utente.

È ora opportuno, prima di procedere alla generazione vera e propria della griglia di calcolo,
denominare opportunamente tutte le superfici di contorno del dominio - patches - agevolando
in tal modo la successiva imposizione delle condizioni al contorno. Come rappresentato in
figura 25, cliccare con il tasto destro del mouse, nell’albero in alto a sinistra, su Model →
Insert→ Named Selection.

Successivamente:
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Figura 23: Schermata iniziale di ANSYS Meshing.

Figura 24: Dettagli sulle Preferences in ANSYS Meshing.

Figura 25: Inserimento di Named Selection in ANSYS Meshing.
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• Rinominare in INGRESSO;

• Selezionare la faccia d’ingresso al tubo a monte della curva, riconoscibile dalla po-
sizione rispetto agli assi coordinati (per comodità: il ramo più corto);

• Premere su Apply, come illustrato in figura 26.

Figura 26: Definizione della faccia INGRESSO in ANSYS Meshing.

Procedere in maniera analoga per la sezione (faccia) di uscita, denominandola USCITA,
come in figura 27.

È infine necessario definire la parete laterale, rinominando la regione in PARETE, come
illustrato in figura 28, ponendo attenzione al fatto che la parete è in realtà costituita da 3
superfici: per eseguire la scelta di più superfici è necessario tenere premuto il tasto Ctrl durante
la selezione.

Una volta completata la definizione delle regioni, possiamo procedere alla generazione
delle mesh adottando i settaggi di default per ciò che riguarda le informazioni sulle dimen-
sioni minime e massime degli elementi, l’algoritmo di generazione della griglia etc. Queste
informazioni sono reperibili cliccando, nell’albero a sinistra, su Mesh → Sizing e Patch
Conforming Options, come illustrato in figura 29.

Per poter generare la mesh, è necessario cliccare sull’icona Generate Mesh ( ),
ed attendere il tempo necessario a completare l’operazione. Il progresso della generazione
della griglia verrà indicato dalle due waitbar in figura 30. In questo caso, trattandosi come
si vedrà di una mesh piuttosto rada, il tempo necessario è trascurabile, mentre nel caso di
geometrie complesse e risoluzione spinta, il tempo necessario può essere dell’ordine delle
ore.

Le griglia risultante, che verrà mostrata nella finestra principale alla fine della generazione,
è riportata in figura 31.
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Figura 27: Definizione della faccia USCITA in ANSYS Meshing.

Figura 28: Definizione della PARETE in ANSYS Meshing.
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Figura 29: Valori di default per il sizing in ANSYS Meshing.

Figura 30: Finestra di stato della generazione della griglia in ANSYS meshing.

Figura 31: Griglia ottenuta, in ANSYS meshing, usando i valori di default per il Sizing.
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La griglia cosı̀ ottenuta, com’è ovvio, è troppo rada per descrivere adeguatamente il
fenomeno: basta osservare, cliccando su Statistics nel menu in basso a sinistra, che il numero
totale di nodi è pari a 4565, ed il numero totale di elementi (si ricordi che ANSYS CFX è un
codice di tipo CVFEM - Control Volume Finite Element Method), è uguale a 3608. Pertanto
è necessario modificare (ridurre) i valori di default per il Sizing, riducendo opportunamente le
dimensioni delle celle. Portando, ad esempio, ambedue i valori di Max Face Size e Max Size
a 5 mm (5×10−3 m), come illustrato in figura 32, si ottiene la mesh di figura 33.

Figura 32: Valori ridotti per il sizing in ANSYS Meshing.

Figura 33: Griglia ottenuta, in ANSYS meshing, usando i valori ridotti per il Sizing.

È tuttavia possibile notare che anche questa griglia è probabilmente inadeguata, soprattutto
per ciò che riguarda la risoluzione a parete. Ritorneremo su tale aspetto nel seguito. Vale
la pena ricordare che, ogniqualvolta vengono eseguite modifiche, è necessario aggiornare
(Update) la mesh, oltre ad aggiornare gli eventuali riferimenti alla mesh da parte di altre celle,
nel nostro caso la cella di Setup. Ciò si esegue o cliccando Update ( ), al posto di
Generate Mesh ( ) in DM, oppure cliccando con il tasto destro del mouse sulla
cella Mesh in WB e selezionando Update, come illustrato in figura 34

Completata la generazione della mesh, è ora possibile chiudere ANSYS meshing (da File
→ Close meshing) e procedere con il Setup del problema, non prima di aver salvato l’intero
progetto in WB (File→ Save).
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Figura 34: Aggiornamento (Update) della cella Mesh in WB.

3.3 Setup del problema
Nella finestra principale posizionarsi con il mouse, nello schema del progetto in WB, sulla
cella Setup cliccando con il tasto destro e selezionare Edit, come in figura 35.

Figura 35: Avvio di ANSYS Setup.

Una volta completato l’avvio di ANSYS Setup, il risultato sarà come in figura 36.
È ora necessario procedere al settaggio di tutti i parametri e le modalità riguardanti la

simulazione, ed in particolare:

• Tipo di analisi (stazionario o non-stazionario);

• Presenza di moti di corpo rigido;

• Caratteristiche del dominio di calcolo;

• Condizioni al contorno;

• Presenza di sotto-domini;

• Sorgenti puntiformi;

• Interfacce;

• Inizializzazione;

• Parametri e schemi del solutore;

• Modalità di output;
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Figura 36: Schermata iniziale di ANSYS Setup.

• Adattività della griglia;

• Parametri di esecuzione.

Le icone di tutte queste voci sono riportate, nell’ordine visto, nella Toolbar di CFX-Pre,
come illustrato in figura 37. Sarà quindi utile e conveniente seguire tale ordine per preparare il
lancio della simulazione, con l’avvertenza che non è necessario settare le voci non pertinenti,
che vanno quindi lasciate ai loro valori di default (ad es. nel caso in esame non vi sono moti
di corpo rigido, né sotto-domini o sorgenti puntiformi, e nemmeno interfacce, ed inoltre non
attiviamo l’adattività della griglia).

Figura 37: Voci della Toolbar di ANSYS Setup.

Trattandosi di un problema stazionario in assenza di moti di corpo rigido (default), è pos-
sibile procedere direttamente alla definizione del Dominio, cliccando sull’icona ( ).
Nominare il dominio Gomito, e verificare quindi che, come illustrato in figura 38, cliccando
su Gomito nell’albero di sinistra (Outline), in Basic Settings il fluido di lavoro è acqua.

Cliccando infine sul Tab Fluid Models, si potrà verificare, come in figura 39, che il flusso
è assunto turbolento, e viene utilizzato il modello RANS (Reynolds Averaged Navier Stokes)
k − ε.

È ora possibile procedere all’imposizione delle condizioni al contorno. Iniziando dalla
condizione all’ingresso, cliccare sull’icona Boundary ( ) e nominarla Ingresso. Successi-
vamente, come illustrato in figura 40, indicare che si tratta di Boundary Type di tipo Inlet,
ed associarla alla patch INGRESSO. Prima di completare la definizione della condizione al
contorno, è necessario impostare alcuni parametri legati al tipo di condizione al contorno.
Cliccare sul Tab Boundary Details, settare il valore della velocità a 0.2 [m/s] lasciando gli
altri parametri invariati, come riportato in figura 41, e cliccare su OK.
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Figura 38: Verifica del fluido di lavoro - Material - del dominio di calcolo.

Figura 39: Verifica del modello di turbolenza utilizzato.

Figura 40: Condizione di Inlet all’Ingresso.

Figura 41: Dati della condizione di Ingresso.
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Si procede quindi analogamente per la condizione al contorno all’uscita: in tal caso, dopo
aver nominato la condizione Uscita ed aver indicato che si tratta di una condizione di tipo
Outlet, associarla alla patch USCITA, come visibile in figura 42. Oltre alla condizione al
contorno di tipo Outlet, che prevede che il flusso sia tutto in uscita, esiste anche la condizione
di Opening, da utilizzarsi quando è prevista la possibilità che, su una parte della sezione, il
flusso possa essere in Ingresso.

Figura 42: Condizione di Outlet all’Uscita.

Cliccare poi sul Tab Boundary Details, ed impostare a 0 [Pa] il valore della pressione
relativa, come in figura 43.

Figura 43: Dati della condizione all’Uscita.

L’ultima condizione da imporre è quella relativa alla parete del gomito. Procedendo nel
modo già visto, si nomini tale condizione Parete e, dopo aver indicato che si tratta di una
condizione al contorno di tipo Wall, associarla alla patch PARETE, come in figura 44.

Figura 44: Condizione di Wall sulla Parete.

Infine, cliccare su Boundary Details ed accertarsi che, come indicato in figura 45, la parete
sia di tipo No Slip e Smooth.

Prima di passare alla fase di soluzione vera e propria, indichiamo lo schema convettivo
(advettivo) da utilizzare in questa prima prova. Cliccando sul’icona Solver Control ( ),
in alto sulla Toolbar o a sinistra sull’Outline, impostare Upwind come Advection Scheme, e
lasciare inalterati tutti gli altri parametri, come indicato in figura 46. È ben noto che lo schema
Upwind, del primo ordine, produce risultati in generale inaccettabili, poiché introduce una
diffusività numerica, non fisica, dello stesso ordine di grandezza, o addirittura superiore, di
quella fisica. Tuttavia, in questo caso l’obiettivo è quello di verificare le conseguenze dovute
all’uso dello schema Upwind assieme ad un criterio di convergenza inadeguato ed un griglia

E. Nobile, M. Morgut, P. Ranut - Febbraio 2013



3.4 Soluzione del problema 25

Figura 45: Dettagli della condizione wall.

eccessivamente rada. Vedremo nel seguito come variano i risultati adottando uno schema
advettivo di ordine elevato, un criterio di convergenza più restrittivo ed una griglia più fine.

Figura 46: Impostazione dello schema advettivo.

Cliccare quindi su OK e chiudere CFX-Pre.

3.4 Soluzione del problema
Nella finestra principale posizionarsi con il mouse, nello schema del progetto in WB, sulla
cella Solution cliccando con il tasto destro e selezionare Edit, come in figura 47.

Figura 47: Avvio di ANSYS Solver Manager.

Apparirà quindi una finestra, di nome Define Run, come in figura 48.
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Figura 48: Finestra di definizione del Run.

Lasciare tutti i parametri invariati e cliccare Start Run. A questo punto si aprirà la finestra
del Solver Manager, caratterizzata dall’andamento grafico dei residui al variare del numero
di iterazioni a sinistra, e da una finestra testuale a destra che riporta i dati salienti ad ogni
iterazione/time-step. Alla fine del calcolo - in questo caso molto breve, trattandosi di una
griglia rada con un criterio di convergenza poco restrittivo - apparirà un avviso di conclusione
normale del calcolo, con indicazione del nome e localizzazione del file dei risultati (estensione
.res), come illustrato in figura 49.

Figura 49: Conclusione del calcolo.

Cliccare OK sulla finestra Solver Run Finished Normally, e poi chiudere la finestra del
Solver Manager.
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3.5 Visualizzazione ed elaborazione dei risultati
Nella finestra principale posizionarsi con il mouse, nello schema del progetto in WB, sulla
cella Results cliccando con il tasto destro e selezionare Edit, come in figura 50.

Figura 50: Avvio di ANSYS CFD-Post.

All’apertura di CFD-Post sarà visibile solo il wireframe del tubo, che consiste nelle due
sezioni di ingresso e uscita. Per evidenziare la geometria sarà sufficiente spuntare la casella,
nell’Outline, a fianco alla voce Parete, come evidenziato in figura 51.

Figura 51: Visualizzazione della geometria del gomito in CFD-Post.

Proviamo ad evidenziare la presenza di moti secondari per mezzo di linee di corrente
(Streamlines). Cliccare, in alto sulla Toolbar, sul simbolo Streamline( ), e nominarlo Stream-
lines. All’opzione Start from, come indicato in figura 52, indicare Ingresso.

Una volta cliccato su Apply, e ricordandosi di rimuovere (spunta) la visualizzazione del
gomito, otterremo delle linee di corrente come in figura 53

Con tale vista è difficile riconoscere la presenza o meno dei moti secondari. Per ovviare a
ciò, cliccare con il tasto destro del mouse all’interno della finestra grafica (graphic window),
e selezionare Predefined Camera→ View From -Z, come riportato in figura 54.

E. Nobile, M. Morgut, P. Ranut - Febbraio 2013



28 3.5 Visualizzazione ed elaborazione dei risultati

Figura 52: Selezione dell’origine delle Streamlines in CFD-Post.

Figura 53: Visualizzazione delle Streamlines in CFD-Post.

Figura 54: Modifica del punto di vista delle Streamlines in CFD-Post.
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Otterremo una vista normale alla sezione a valle del gomito che, ricorrendo anche allo
spostamento (Pan) ( ) ed allo Zoom (Zoom Box) ( ), consentirà una visualizzazione come
in figura 55.

Figura 55: Visualizzazione dei moti secondari tramite le Streamlines in CFD-Post.

Come si può notare, le linee di corrente indicano la presenza di moti secondari, sebbene
di intensità inferiore a quanto rilevato sperimentalmente.

È possibile visualizzare i moti secondari anche attraverso la visualizzazione dei vettori di
velocità. Per far ciò, definiamo prima un piano immediatamente a valle della curva: come
indicato in figura 56, cliccare su Location→ Plane.

Figura 56: Creazione di un piano.

Nominiamo questo piano Piano valle, e nella sezione Details a sinistra, selezionare come
Method XY Plane, e impostare Z a -125 [mm] (porre attenzione all’unità di misura), come
indicato in figura 57. Abbiamo quindi creato un piano in corrispondenza dell’uscita del gomi-
to, su cui rappresentare il campo vettoriale dei moti secondari e, come si vedrà in seguito, un
contour plot del modulo della velocità, da confrontare con i rilievi sperimentali riportati in
figura 2.

Disattivare, per maggior chiarezza, la visualizzazione del piano appena definito e delle
linee di corrente spuntandoli dall’albero a sinistra, e procedere alla visualizzazione dei vettori
di velocità sul Piano valle, cliccando sul simbolo Vector ( ). Nominare questo come Vettori
valle, e nella finestra Details a sinistra, impostare Piano valle come locations, e Tangential
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Figura 57: Impostazione dei dati del Piano valle.

Figura 58: Impostazione dei dati di Vettori valle.

come Projection, come evidenziato in figura 58. La proiezione tangenziale dei vettori di
velocità, consente una migliore visualizzazione dei moti secondari.

Una volta cliccato su Apply, il risultato sarà analogo a quello di figura 59.

Figura 59: Visualizzazione dei moti secondari tramite i vettori di velocità sul Piano valle.

I vettori di velocità indicano la presenza di moti secondari, ma nuovamente non è agevole
confrontare tale risultato con i rilievi sperimentali visti in figura 2. È preferibile visualizzare
le curve isolivello - contours - della velocità sul Piano valle, in analogia ai rilievi sperimentali
di figura 2. Per far ciò, dopo aver disattivato la visualizzazione dei vettori velocità sul Piano
valle, cliccare sul simbolo Contour ( ), e nominarlo Contour valle. Nella finestra Details a
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sinistra, impostare Piano valle come locations, Velocity come Variable, e lasciare tutto il resto
ai valori di default, come illustrato in figura 60.

Figura 60: Settaggio dei dati per Contour valle.

Cliccando come al solito su Apply, il risultato sarà analogo a quello di figura 61 dove, per
convenienza, è stato riportato nuovamente anche l’andamento sperimentale della velocità, al
fine di agevolare il confronto (notare che le due figure sono ruotate, una rispetto all’altra, di
90◦).

Figura 61: Visualizzazione delle curve di isovelocità sul Piano valle, a sinistra sperimentali,
a destra numeriche.

Il campo di velocità ottenuto numericamente presenta una certa rassomiglianza con quello
sperimentale ma, come già osservato precedentemente, vi sono senz’altro delle differenze.

Un’analisi più quantitativa - e che potrebbe costituire una delle ragioni del calcolo - riguar-
da la valutazione delle perdite di carico. Si tratta, in questo caso, di una perdita di carico
localizzata, che solitamente viene espressa mediante una relazione del tipo:

∆p = K
1

2
ρU2 (1)

dove il coefficiente empirico K varia in funzione di:

• rapporto rc/D, con rc raggio di curvatura dell’asse della curva (v. figura 2);

• tipo di superficie, liscia o scabra;

• numero di Reynolds.
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Per la valutazione della perdita di carico possiamo calcolare la pressione sui due piani
immediatamente a monte (X = 0 mm) ed a valle (Z = -125 mm) della curva. Avendo già
definito in precedenza il Piano valle, definiamo, con analoga procedura, un piano aX = 0 mm
che chiameremo Piano monte.

Successivamente, cliccando sull’icona Function Calculator( ), è possibile valutare il val-
ore medio della pressione su ambedue i piani. Per far ciò, come illustrato in figura 62, se-
lezionare la funzione areaAve, indicare come location Piano monte, come Variable Pressure,
e quindi cliccare Calculate.

Figura 62: Valutazione del valore medio della pressione sul Piano monte.

Come si può notare in figura 62, il valore della pressione media sul Piano monte è pari
a pmon = 9.11 Pa. Procedendo analogamente sul Piano valle, si ottiene pval = 4.54 Pa,
ottenendo quindi un salto di pressione pari a ∆p = pmon − pval = 4.57 Pa.

È utile notare che, come indicato nell’help di CFD-Post, la funzione areaAve valuta il
valore medio di una variabile tenendo conto della non-uniformità della griglia. Viceversa, la
funzione ave calcola una semplice media aritmetica per tutti i nodi (interpolati) che giacciono
sulla location indicata, e non tiene quindi conto delle diverse dimensioni delle celle. Per tale
ragione nel nostro caso va utilizzata la funzione areaAve, poiché più accurata.

La tabella 2 riporta il confronto fra il valore della perdita di carico ottenuta dal calcolo, e
quella - ottenuta da rilievi sperimentali - riportata da alcune fonti bibliografiche.

Caduta di pressione [Pa]

CFD 4.57

A. Ghetti (1977) 3.50
Idel’cik (1960) 2.64
ASHRAE (1986) 2.40

Tabella 2: Confronto fra il valore della perdita di carico calcolata e quella riportata in
letteratura.

Come si può notare, il risultato ottenuto per via numerica è sensibilmente maggiore dei
valori di letteratura. Come anticipato in precedenza, tali differenze vanno imputate all’uso
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dello schema Upwind del prim’ordine e, in minor misura, all’uso di un criterio di convergenza
inadeguato e una griglia troppo rada.

4 Miglioramento dell’accuratezza

4.1 Schema advettivo e criterio di convergenza

Un primo miglioramento sensibile può essere ottenuto agevolmente adottando lo schema ad-
vettivo HR (High Resolution), meno diffusivo, ed un criterio di convergenza più restrittivo,
con un valore del residuo RMS pari a 1 × 10−5, mantenendo inalterata la griglia e tutti gli
altri parametri. Per far ciò, aprire nuovamente, in Workbench, la cella Setup, e modificare lo
schema advettivo ed il criterio di convergenza come riportato in figura 63.

Figura 63: Impostazione dello schema advettivo HR e del criterio di convergenza.

Si osservi tuttavia che, come visibile in figura 63, è stato mantenuto lo schema UDS per
le equazioni del modello di turbolenza: in tal caso, infatti, l’errore dovuto alla diffusività
numerica è, in generale, di minore entità - l’effetto si manifesta solo indirettamente attraverso
il valore della viscosità turbolenta - e nel contempo è garantita una maggior robustezza del
calcolo.

Dopo aver salvato le modifiche, è conveniente far ripartire il calcolo utilizzando, come
valori iniziali, la precedente soluzione. Ciò è eseguito di default in CFX: infatti, come indicato
in figura 64, CFX utilizzerà, ove possibile, la Current Solution Data. In altri casi, come
vedremo più avanti, sarà possibile esplicitare direttamente il file di soluzione (estensione .res,
results file) da utilizzare come condizione iniziale.

Dopo aver fatto partire il calcolo i valori dei residui, come illustrato in figura 65, crescer-
anno inizialmente, per poi ridursi sino al valore imposto nel criterio di convergenza.

Procedendo poi all’analisi dei risultati, si potrà immediatamente notare che il contour delle
velocità, qua non riportato per brevità, è più prossimo alle curve rilevate sperimentalmente, e
che la perdita di carico risulta in questo caso pari a ∆p = 3.35 Pa, valore sensibilmente più
vicino ai dati sperimentali riportati in tabella 2.
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Figura 64: Utilizzo di default della soluzione corrente nel restart.

Figura 65: Conclusione del calcolo con schema advettivo HR e criterio di convergenza più
restrittivo.
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4.2 Raffinamento della griglia
Procediamo ora, a scopo illustrativo, a raffinare la griglia utilizzando uno dei possibili approc-
ci disponibili in ANSYS Meshing. A tal fine è conveniente duplicare il progetto all’interno
di Workbench: per far ciò cliccare sul simbolo - triangolo rovesciato - in alto a sinistra del
progetto ( ) e selezionare Duplicate, come indicato in figura 66.

Figura 66: Duplicazione e rinominazione del progetto in Workbench.

Una volta duplicato sarà conveniente, usando la stessa modalità come illustrato in figu-
ra 66, rinominare i due progetti rispettivamente Gomito e Gomito refined. Con riferimento a
quest’ultimo, clicchiamo su Mesh e procediamo al raffinamento della griglia.

Anziché aumentare semplicemente la risoluzione della griglia attraverso una riduzione del
Sizing, vale a dire Max Size e Max Face Size, è preferibile operare in modo selettivo, privile-
giando, ad esempio, la risoluzione in prossimità delle pareti solide, per meglio descrivere gli
strati limite. A tal fine, nell’albero di sinistra, cliccare col tasto destro del mouse su Mesh→
Insert→ Method, come illustrato in figura 67.

Figura 67: Inserimento di un metodo di generazione della griglia in Mesh.

Nel menu Details di sinistra, come riportato in figura 68, selezionare l’intero gomito (1
Body) come Geometry, Sweep come Method, e alla voce Src/Trg Selection scegliere Manual
Source and Target. Selezionare poi come Source and Target, rispettivamente, la sezione di
entrata e la sezione di uscita del gomito. Indicare infine 150 come Sweep Num Divs.

Una volta eseguiti questi passi, è possibile visualizzare la mesh risultante cliccando su
Generate Mesh. Poiché la mesh ottenuta in questa fase intermedia non verrà utilizzata, non è
necessario cliccare su Update che, lo ricordiamo, provvede anche ad aggiornare l’output dalla
cella in esame - in questo caso Mesh - e le celle collegate, Setup in tale problema. Si potrà
tuttavia notare che la mesh ottenuta ha una risoluzione solo di poco superiore alla precedente
- il numero di nodi è passato da 34322 a 40770 - ma è ancora inadeguata per ciò che riguarda
la risoluzione in prossimità delle pareti.

Il passo successivo, quindi, è quello di aumentare/migliorare la risoluzione a parete, e per
far ciò andremo a creare uno strato di celle estruse, di altezza opportuna, a parete. Come fatto
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Figura 68: Scelta dettagli del metodo di generazione della griglia in Mesh.

in precedenza, nell’albero di sinistra cliccare col tasto destro del mouse su Mesh→ Insert→
Inflation, come illustrato in figura 69.

Figura 69: Inserimento di strato di celle estruse a parete in Mesh.

Nel menu Details di sinistra, come indicato in figura 70, verificare che come Scoping
Method sia riportato Geometry Selection, e come Geometry selezionare la faccia corrispon-
dente alla sezione di entrata. Analogamente verificare che come Boundary Scoping Method sia
riportato Geometry Selection, e indicare come Boundary il bordo della faccia appena scelta.
Infine, come Inflation Option, selezionare First Layer Thickness, inserendo, ad esempio, 0.4
mm come First Layer Height, il valore 8 come Maximum Layers e 1.2 come Growth Rate.
Completati questi passi, visualizzare la mesh cliccando su Generate Mesh.

Dalla disamina della griglia cosı̀ ottenuta, si può notare che, sebbene la risoluzione a
parete sembri adeguata, la discretizzazione lungo la circonferenza è certamente grossolana,
come visibile in figura 71.

Per ovviare a ciò, una possibile soluzione è quella di ridurre, in Sizing, la dimensione
massima della faccia, Max Face Size, abbassandola da 5 mm a 2.5 mm. Operata questa mod-
ifica, la griglia risultante che si ottiene, riportata in figura 72, è caratterizzata da risoluzione
adeguata sia in direzione circonferenziale che in direzione normale alla parete.

Un analogo risultato si sarebbe ottenuto lasciando inalterato il valore di Max Face Size, e
settando a 5◦ il valore di Curvature Normal Angle.

Dopo aver eseguito l’update della Mesh e, in Workbench, l’update della cella Setup, aprire
la cella Solution per procedere al setup della simulazione. In tal caso, non avendo eseguito
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Figura 70: Scelta dettagli per lo strato di celle estruse a parete in Mesh.

Figura 71: Mesh con inadeguata risoluzione lungo la circonferenza.

Figura 72: Mesh con idonea risoluzione lungo la circonferenza.
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precedenti analisi - le simulazioni precedenti erano relative al progetto Gomito mentre ora
stiamo operando sul progetto Gomito refined - è opportuno utilizzare, come condizioni in-
iziali, gli ultimi risultati ottenuti sulla griglia rada, che verranno opportunamente interpolati
sui nodi della griglia attuale. Per far ciò, una volta aperta la finestra Define Run di CFX-Solver
Manager, settare Initial Conditions come Inizialization Option, abilitare Initial Values Spec-
ification ed indicare il nome del file dei risultati ottenuto sulla griglia più rada, tipicamente
...\dp0\CFX\CFX\Fluid Flow CFX_002.res, come indicato in figura 73.

Figura 73: Utilizzo della soluzione ottenuta sulla griglia rada come condizione iniziale.

Una volta concluso il calcolo, che in questo caso richiederà un tempo maggiore visto il
numero di nodi sensibilmente superiore, si potrà verificare che la perdita di carico risulta pari
a 3.19 Pa, dato ancora più vicino ai valori sperimentali riportati in tabella 2.

5 Considerazioni conclusive ed ulteriori attività
Come si è potuto verificare, l’accuratezza dei risultati numerici dipende molto dagli schemi
numerici della simulazione - schema convettivo e criterio di convergenza - e dalla qualità e
risoluzione della griglia di calcolo. Vi è inoltre la questione, non affrontata in questo semplice
esercizio, dell’errore di modellazione.

Fra le possibili attività lasciate allo studente interessato, si segnala:

• Utilizzo di una sola metà del dominio di calcolo fin qui considerato, sfruttando il piano
di simmetria passante per l’asse del gomito.

• Utilizzo di altri modelli di turbolenza, quali l’SST (Shear Stress Transport), o RSM.

• Imposizione di un profilo di velocità turbolento completamente sviluppato all’ingresso,
per ridurre gli errori dovuti al mancato sviluppo dinamico e/o ridurre la lunghezza della
tubazione di entrata.
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